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Weintek HMI to BACnet IP Device

Introduction: This instruction manual discusses how to communicate with a BACnet IP

server. BACnet is a communication protocol designed for building automation. The

BACnet protocol defines the object types and the properties for each object type. All

BACnet objects consists of a number of properties for information exchange. The table

below shows you the common BACnet object types. A device that is compatible with

BACnet protocol must have only one instance of Device object type for its structure. An

instance number is the way to identify items within an object type.

Object Type Object Type ID Example of Use

Analog Input 0 Analog sensor input

Analog Output 1 Command output

Analog Value 2 Setpoints or parameters

Binary Input 3 Digital sensor input

Binary Output 4 Relay output

Binary Value 5 Digital logic

Device 8 Device information, supported object types
and services

Multi-state Input 13 Represents the states of the process, such as
OFF, ON, AUTO

Multi-state Output 14 Represents the desired states of the process

Multi-state Value 19 Represents multi-state indicators

There are many properties of the object types that are used to monitor and control a
BACnet-compatible device. Some properties apply only to certain object types, but
every object type must have at least three properties, including Object_ldentifier,
Object_Name, and Object_Type. For example, the table below shows you some of the
properties within Analog input, instance number 1. A BACnet IP client issues the
Read_Property service to the BACnet IP server in order to get temperature data from
the Present_Value property.

Properties Name Properties Value

Object_Identifier Analog input, instance 1

Object_Name Office temperature

Object_Type Analog input
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Present_Value 72.2

Event_State normal

Units Degrees Fahrenheit
High_Limit 95.0

Low_Limit 40.0

The object types supported by a BACnet device can be found under the Protocol Object
Types Supported property of the Device object type or in the user manual of the device.

Device

r* Device
instance 105
~* Analog Input
Analog Input, instance 0
I: Properties.....
Analog Input, instance 1
l: Properties.....
r* Analog Value
Analog Value, instance 0
L Analog Value, instance 1
r* Analog Output
Analog Output, instance 0
Analog Output, instance 1
—* Binary Output
Binary Output, instance 0
Binary Output, instance 1

BACnet IP Object Modeling

Equipment & Software:
1.EasyBuilder Pro v6.03.02.294
2. Weintek HMI cMT3090

3. BACnet IP server device
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Detail of the HMI Programming: Open a new project and choose the HMI model
cMT3090. To get the HMI talking to the BACnet IP server, go to the [HOME] tab on the
top of the menu and then click on the [System Parameters] button.

EasyBuilder Pro : EBProject] - [10 - WINDOW_010 ]
LIGUMN Project  Object  Data/History  lloT/Energy  View  Tool

k OO Find/Replace Addr | | @ -] £ 123 B s -
Paste Cop: System Select Multi. copy BE . 57 OGO~

Parameters - QWindowcop}r e A B [ HH @ B R i =
Editing Object

Clipboard

Search for [BACnet/ IP] driver from the list of the device drivers.
I/F: Ethernet

Enable [Read Property Multiple] Service: This option depends on the server
device.

Enable COV (Change of Value): If enabled, enter the number of seconds
between two COV subscriptions. Please check with the device manufacturer
if your device supports the COV feature.

Device Settings X

Mame : \ BACRet/IP ‘

(@) Device

Location : Lacal Settings...

* Select Local for a device connected to this HMI, or Remote for a device connected through another
HML.

Device type : BACnet/IP | »
Device ID : 405, V.4.10, BACNET _IP.c30

IfF: Ethernet ~ | Open Device Connection Guide:

*Support offdine simulation on HMI {use LB-12358).

IP: [192.168.1.111, Port=47808, HMI port no. =47308 Settings...

Enable [Read Property Multiple] service
[1Enable oV (Change Of value)

Conce
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IP address: Enter the IP address of the device.

Port no.: Enter the port number of the device. By default the BACnet device
uses 47808.

Mode: Select a correct mode according to the specification of the device.

e Normal (the Normal mode is used in this manual.)

IP Address Settings
IP address : 192 . 168 . 1 . 111 Who Is...
Portno. :
Mode : ‘ Normal v|
Maximum number of segments accepted : ‘ Unlimited ~ |
Maximum APDU length accepted @ ‘ 480 (fits ARCNET frame) ~ |

Timeout (sec) @ 1,9 - Turn around delay (ms) :
HMI port no. © | 47308
Device ID (0~4194302) : | 342566

The number of resending commands : | ~

Cancel

e [BACnet/IP to MS/TP] Adapter

e [BACnet/IP] Server
If selected, enter the Length and MAC(Hex) within Ultimate
destination MAC layer address. Enter the MS/TP network number to
Network number.

IP Address Settings
IPaddress: | 192 . 1683 . 1 . 100 Who Is...
Fortno. :
Mode : [ [BAChet/IP to Ms/TP] Adapter v
Maximum number of segments accepted : | Unlimited v|
Maximum APDU length accepted : | 480 (fits ARCNET frame) V|

Ultimate destination MAC layer address

Length :
MAC (Hex)

Timeout (sec) : |1.g ~ Turn around delay (ms) : D
HMI port no. : | 47308
Device ID (0~4194302) : | 342566 Metwork number : I:I

The number of resending commands : | g V

Cancel
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Maximum number of segments accepted: The number of segments sent before sending
a reply. It is specified by the device's Segmentation_Supported.

Maximum APDU length accepted: The actual packet length on BACnet network. It is
specified by the device's Max_APDU_Length_Accepted.

Device ID: Enter the instance number of the device.

You can click on the [Who is] button to discover the device on the BACnet network.
Make sure your PC and the device are on the same subnet. If the device is discovered,
the IP address and Device ID of the device will be shown as below.

Accessible Modes >
Device No IP Address
4194302 192.168.1.100
Cancel

After the above communication settings are finished, you will need to import
tags (BACnet object types). Easybuilder Pro supports the following two
methods.

e [Tag Manager...]: It reads the tag information from the device directly.

e [Import Tag...]: Certain BACnet IP clients, such as SCADA, have the
capability to export tag information as a CSV or EDE (Engineering Data
Exchange) file from a discovered device. These files can be imported
into Easybuilder Pro.
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Method 1- Tag Manager

Click on the [Tag Manager...] button.

System Parameter Settings *
Cellular Data Metwork Time Sync. /[DST e-Mail Redipe Database
Device Model General System Remote Security Extended Memory
Device list: What's my IP?

MName Location  Device Type Interface IfF Protocol  Station Mo.

~ |Local HMI| Local HMI Local cMT3090 (1024 x 768) - - a
BACnet... Local BACnet/TP Ethernet ... TCP/IP MNfA

Mew HML... Mew Device/Server... Delete Settings. ..
Import Tags... Tag Manager... Export Tag...

Click on the [Get Tag Info...] button. The tag information will be gathered.

Tag Information

Device Tags...

Get Tag Info... Group Object Settings... Save Exit
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The available object types will be listed as below once it succeeds.

Device Tags...

= [~Device 4194302

EasyBuilder Pro *

| Get tag information successfully, Please click [Exit].

Get Tag Info... Group Ohject Settings. .. Save Exit

You can select which object types you need to use in this project or select all
of the objects. Click the [Save] button to confirm.

Tag Information

Device Tags...
B o ce +15-c02)

EIIZ AnzlogValue
-[#1(2,0)AnalogValue-(analogValued)
= 2, 1)AnalogValue-{AnalogValue 1)
2,2)AnalogValue-{AnalogValueZ)
= 2,3)AnalogValue-{AnalogValue3)
- [1(2,9)AnalogValue{AnalogValued)
- [Binaryvalue
-.[+(5,0)Binaryvalue-(BinaryValue)
= , 1)BinaryValue-{Binaryvalus 1)
;2)BinaryValue-{BinaryValue 2)
= ,3)BinaryValue-{BinaryValue 3)
[ (5,9)Binar yValue-(Binaryvalus4)
- Device

GetTag Info... Group Object Settings... Exit
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You can create a CSV file that contains the object types in the project using
the [Export Tag...] button and import into another project.

Cellular Data Metwork Time Sync./DST e-Mail Recipe Database
Device Model General System Remote Security Extended Memory
Device list: What's my IP?
Mame Location  Device Type Interface

~ Local HMI Local HMI  Local cMT3050 (1024 x 768) -

Local Device 4 BACnet/IP Local BACnet/TP Ethernet {IP=192. 168. 1. 100, Port=4730
< >

MNew HML... Mew Device/Server... Delete Settings...

Import Tags. .. Tag Manager... Export Tag...

The CSV file can be opened in Excel. The tags starting at line 6 are listed in
the following format.

[Device_ID], [Object_Type], [Object_Instance], [Object_Name], [Description]

A B C D E
1 |GROUP_ID GROUP_NAME
2 1 New Group
3 |DEVICE_ID GROUP_ID DEVICE_MNAME
4 4194302 1 Device
5 |DEVICE_ID OBJECT_TYPE INSTANCE OBJECT_MNAME DESCRI
6 4154302 2 0 AnalogValue AnalogValued
7 4194302 2 1 AnalogValue AnalogValuel
8 4194302 2 2 AnalogValue AnalogValue2
g 4194302 2 3 AnalogValue AnalogValue3
10 4194302 2 4 AnalogValue AnalogValued
11 4194302 5 0 BinaryValue BinaryValue0
12 4194302 5 1 BinaryValue BinaryValuel
13 4194302 5 2 BinaryValue BinaryValue2
14 4194302 5 3 BinaryValue BinaryValue3
15 4194302 5 4 BinaryValue BinaryValued
16 4154302 8 4194302 Device BACnet Server
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Method 2- Import Tags

Click on the [Import Tags...] button.

System Parameter Settings

Cellular Data Network
Device

BACnet IP Device

Time Sync. [DST

e-Mail Recipe Database
Model General System Remote Security Extended Memory
Device list: What's my IP?
Mame Location  Device Type Interface  IfF Protocol  Station No.
~ Local HMI Local HMI Local cMT3090 (1024 x 768) - - a
lloc.. BACnet... Local BACnet/TP Ethernet ... TCR/IP MjA
Mews HML.... New DeviceServer... Delete Settings...
Import Tags... Tag Manager... Export Tag...

Navigate to your EDE file or the CSV file you
Method 1.

exported from EasyBuilder Pro using

Open
« v 4 B ThisPC v|®  Search ThisPC
Organize + C
IS
&# Dropbox ~ Folders (7)
@ OneDrive 3D Objects Deskiop
[ This PC
B 3D Objects ;= Documents Downloads
[ Deskiop = ‘
] Documents Music Pictures
¥ Downloads —
b Music
— Videos
&) Pictures m
[ videos
iy Windows (C) ~ Devices and drives (3)
RECOVERY (D:) - Windows (C:) RECOVERY (D:)
-
= Samsung_T3 (E:) T~y

I
94,8 GB free of 221 GB L]

File name:

1.84 GB free of 13.5GB

v
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Once the tags are imported, click the [OK] button on the following dialog.

EasyBuilder Pro >

| Imported tag information successfully.

How to read Present_Value property of Analog Value
Create a Numeric object and specify the tag by clicking the [Tag] box.

In this case, the Present_Value is read-only data. Unchecking [Allow input] is necessary.

Mew Murmeric Object x

General  Format Security  Shape Font

Description :

[ allow input

Read address
Device : | BACnet/TP ~ || Setlings...
Tag: |0 w [
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Select the Present_Value under (2,0) Analog Value, which is the instance 0 of Analog

Value.
PES Tags ¥z (204nalogValue ¥ Q :|
v 9 Tags Name Data type Description
~ Rz (2,0)AnalogValue
B8 ObjectName(D#77)(32] B8 ObjectName(D#77) SINTI32]
BB PresentValueArray(ID#85)[100] . .
BB BriortyAmay(DSEDI17] I Objectldentifier(ID275) DINT
%2 (2 1)Analoghalue I ObjectType(ID=79) INT
Rz (22)AnzlogValue ectTypellDETS)
g (2.3)Analoglalue B PresentValue(ID85) REAL
Tz (2.4)Analoglalue
2 (5,0)BineryValue BB PresentValucAnay(ID#25) REAL[100]
Rz (5,1)BinaryValue
2 (5 2BinanyVelue I EventState(ID36) DINT
Rz (5,3)BinanyValue
o o Bimeue B Units(ID#117) DINT
Ha (8,4104302) Device I Priority(ID=85) SINT
B8 PriorityAmay(ID£87) REAL[17]
[ RelinquishDefault(ID#104) REAL
B SubscribeCovTime(ID275) DINT
[ HighLimit(ID#45) REAL
I LowLimit(ID#59) REAL
[ DezdBand(ID#25) REAL
I NotificationClass(ID#17) DINT
) NotifyType(ID£72) SINT
I TimeDelay(ID£113) DINT
[ show deseription
Tag: [, ! D#55) ok
Once the tag is selected, go to the [Format] tab.
New Murmeric Object >
General  Format Security Shape Font
Description @
[] allow input
Read address
Device : | BACnet/IP w || Gettings...
Tag: (2,0)AnalogValue.Presentvalue{lD#35) « |REAL
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Under the [Format] tab, enter the number of digits used in this tag as well as the
device’s low limit and high limit. Click the [OK] button to finish setting up this object.

Mumeric Object's Properties X

General DataEntry Format Trigger Action Setting Security Shape Font  Profile

Display
Device data format : | 32-bit Float w| [Imask
Mumber of dm&ts

r Left of decdmal Pt. : | 4 ':" Right of dedmal Pt. : | 1 ':" 1

Scaling
Method : | Ngne ~
Limits
(®) Direct () Dynamic limits
Device low : I:I Device high & | 3999 I
Tnputlow: 0.0 Inputhigh: | 99990 r

Place the Numeric object onto the editing area.

REA L-(2 M)A nalogy alue Presenty alue(IC#E5)
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How to read/write Present_Value property of Binary Value

Create a Bit Lamp object and specify the tag by clicking the [Tag] box.

Mew Bit Lamp,Toggle Switch Object x

General  Security Shape Label

Comment : | |

(®) Bit Lamp () Togale Switch
Read address
Device ¢ | BACnet/IP w Settings...
Tag: 0 [
[J1rwvert signal

Select the Present_Value under (5,1) Binary Value, which is the instance 1 of Binary
Value.

Al ]

*E9 Tags *Sz G1Binanvaluz >

(2,0)AnalogValue
(2,1)AnalogValue
(2,2)AnalogValue
(2,3)AnalogValue
(24)AnalogValue
(5,0)BinaryValue

(5,1)BinaryValue

BB PresentValueArray(ID285)[100]
B8 PriorityReset(ID=83)(17]

B8 PriorityArray(ID£87)(17]

%2 EventEnable(D#35)
(5,2)BinaryValue

(5,3)BinaryValue

(5,4)BinaryValue

(64194302 Device

il

] show aesaription

Name
I PresentValue(D285)
BB PresentValueArray(ID#85)
BB PriorityReset(ID285)
BE PriorityArray(1D=87)
B OutdfSenvice(ID#51)
B AlarmValue(ID=6)

%3 EventEnable(ID#35)

BOOL
BOOL{100]
BOOL17]
BOOL[17]
BOOL
BOOL

EVENTENABLE

Data type

Description

Tag: |(5,1)BinaryValue.

ok
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In this case, the tag allows an operator to control the device. Select Toggle Switch to
enable the control function.

Mew Bit Lamp/Toggle Switch Object >

General Security Shape  Label

Comment : | |
(®) Bit Lamp () Toggle Switch
Read address
Device @ BACRet/TP ~ Settings...
Taa: (5, 1)BinaryValue.PresentValue(ID£85) v |[BOOL
[Jinvert signal

Within the Attribute, select Toggle.

Toggle Switch/Bit Lamp Object's Properties X

General Security Shape Label  Profile

Comment : |

() Bit Lamp (®) Toggle Switch

[ readwrite use different addresses
Read/\Write address

Device : | BACnet/IP ~ || Settings...
Tag : | (5,1)BinaryValue.PresentValue(ID#85) ~ |BOOL
Oinvert signal

[Jwirite when button is released

Attribute
Switch style : Togg|e L
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Place the Toggle Switch object onto the editing area.

BOOL-(5 1)BinaryYalue PresertV aluel IC&E5)

L]

How to read/write Object_Name property

Some properties are CharacterString data in a BACnet device, such as Object_Name and
Object_Description. Those properties in Easybuilder pro are defined as an array of SINT.

To access those properties, create an ASCIl object. Click on the [Tag] box.

Mew ASCIl Object *

General DataEntry Security Shape Font

Description : | |

Allow input

[Imultiine display
* ASCII value of line feed (LF) character : 10 (OxA)
[IMask [Jreverse highflow byte

Data format
[Junicode

Read/Write address
Device : |BACnet/IP w || Settings...
Tag: |0 + | |1 word(s)
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Select the first element of the array under Object_Name.

MES Tags *%s (24)AnalogValue b B ObjectName(ID£77I[32] ¥ Q |:|
v Tegs Name Datatype Desaription ~
2 (20)AnalogValue T o
an SINT
v @ SINT
apa SINT
|y SINT
[ SINT
@ SINT
am SINT
| SINT
ap SINT
@ [0 SINT
| SINT
@na SINT
|3 SINT
g SINT
o 5] SINT
@ e SINT
|7 SINT
g SINT
o (g SINT
@ o SINT
o 21 SINT
|2 SINT
|23 SINT
[ Show description e o v
Tag: [ ) ok

Click the [Settings...] button to enter the number of characters used by this property.

Note: the unit of string data in Easybuilder Pro is Word.

Read/\Write address
Device ! |BAChet/IP w | Settings...
Tag : | (2,4)AnalogValue. Objectiame(ID£77)[0] w |[L word(s)
|
x
Device : | BAChet/IP ~
Tag : | (2, 9)Analogvalue, ObjectName(ID£77)[0] e

Data type : | SINT |

[Jindex register

Element count :

Cancel
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In this case, check [Allow input] to allow an operator to change the name of the object
type on the HMI screen.

Mew ASCIH Object >

General Data Entry Security Shape Font

Description : | |

Allow input

[JmMulti-ine display
* ASCII value of line feed (LF) character : 10 (0xa)

[Imask []Rreverse high/low byte

Data format
[Junicede

Read/Write address
Device ! |BACnet/IP v (et ]
Tag: |(a%nnaloQValue.Dbjechameun#m [0] v ||1u word(s)

Place the ASCII object onto the editing area.

SINT-(2,4)A nalogV alue. Obje citame( D87 7)[0]
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BACnet is a registered trademark of American Society of Heating, Refrigerating and Air-
Conditioning Engineers (ASHRAE).

[e

1
WIWENTEKm Founded in 1996, WEINTEK LABS is a global-leading HMI manufacturer

and is dedicated to the development, design, and manufacturing of practical HMI
solutions. WEINTEK LAB’s mission is to provide quality, customizable HMI-solutions that
meet the needs of all industrial automation requirements while maintaining customer
satisfaction by providing “on-demand” customer service. WEINTEK LABS brought their
innovative technology to the United States in 2016, WEINTEK USA, INC., to provide
quality and expedient solutions to the North American industrial market.

6219 NE 181s Street STE 120

Kenmore, WA 98028
425-488-1100
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